ABOUT THE REPORT TEMPLATE

This template may be used during the writing of your doctoral dissertation or may be used once you have completed your writing work and you transfer it into the template file that will then be used for submission to the Graduate School, K-REx (K-State Research Exchange), and ProQuest.  (ProQuest is for doctoral students.) The final PDF that you submit is generated from the Word template to ensure formatting. Please review the notes in this document and the resources located on the K-State’s ETDR website.

Why a doctoral dissertation template?  This template ensures proper formatting of the contents of a doctoral dissertation, so all the required information is present and in the proper format and order.  This template also ensures easy navigation through the electronic file, when clicking on items in the Table of Contents or List of Figures or List of Tables will jump a reader directly to the proper location in the file.  The contents of this template also show an informational hierarchy based on the text styles and order.  As such, the contents are both human- and machine-readable. 

Most up-to-date version of MS Word installed.  Please make sure that you have the most up-to-date version of Microsoft Word from the K-State provided Microsoft Office 365. 

Live Web links.  Another way to ensure proper navigation is to make sure that your http links are activated.  You may just need to add/click one space after the URL, and MS Word will turn it into a link for you.  

Font type changes.  In general, use the given font in the template.  However, if you are determined to change the font, change it in one location, by changing it in the Word text Style for Body Text.  Do not highlight text manually and change the font, it will not be applied consistently in the template. 

Handling digital images.  This template was set up so that all inserted images are not compressed inside Word (so they retain high resolution quality).  The setting is High Fidelity. For images, please use .jpg format.  If image resolution is of particular importance, go with less lossy digital image formats like .png or .tif.  Typical image standards for publication are 350 dpi at minimum.  Color for print is CMYK format (vs. RGB for web). While your template initially begins as a Word file, it will ultimately be saved as a.pdf file for digital archival and distribution which retains these image details.

Bibliographic citations.  Different disciplines have different standards for citing sources both in-text and in the bibliographic listing at the end.  These standards also determine labeling for figures and tables.  It is important to be correct and consistent in the citations.  

List of Abbreviations / List of Terms / List of Equations?  Some works contain a list of abbreviations.  Where these are placed and how they are formatted depend on the discipline.  For some disciplines, the List of Abbreviations follows the List of Tables.  For others, this list may appear elsewhere in the formal thesis.  The formal sequence to place anchors for the respective elements would be the sequence:  References tab -> Captions -> (Object).  
Proper name of student on the Copyright page and proper file name format.  The format for your filename is FirstnameLastnameYYYY.pdf.  Note the capitalization of the first and last name and the lack of any blank spaces in the name. The year is represented with four numbers.  An example would be WillieWildcat2024.pdf.  In some cases, various middle names or middle initials may be included. 

An important thing is to ensure that your name in the file name and copyright matches what is in KSIS as your official name. Log into KSIS.  Go to the Profile file.  Check your “Primary” name and ensure that that is what is used in the ETDR file. Note on the Copyright page there are spaces. 

[bookmark: _Hlk43198765]Supplementary files.  You may need to include related slideshows, articles, datasets, image sets, and other related contents.  These are not added to the document but can be included during your submission of your thesis into K-REx and ProQuest.  Sometimes, students want to embed data tables and datasets in Word. These do not carry over into the .pdf file so should be included separately. 

Maximum .pdf size.  There is a 10 GB size limit for ETDRs on K-REx and ProQuest.  Note that this is the size of a compressed .pdf, which is often a lot smaller than the Word file.  

Omitting blank pages.  Please review your manuscript and remove any blank pages. You may need to adjust the spacing before Page Breaks to move them up and eliminate a blank page. Make sure that the new pagination in your Table of Contents is correct with an update after your remove pages.  

A bound print copy of your work.  To obtain a personal bound copy of your manuscript, see the option at https://www.k-state.edu/grad/academics/etdr/write/#bound 

Highlighted notes.  In this template, there are some highlighted parts (in yellow) to further explain how the template works, along with these instructions.  All highlighted text and formatting notes should be deleted before finalizing your file.  

Field shading.  The grayed parts of the template highlight field shading for automated parts of the template.  Do not type directly into these fields.  The chapter and section titles and caption labels in these gray fields are auto generated from the use of Word Styles (Headings 1-9, and Captions). You type your text in the document, the apply the appropriate heading or caption style, and then they appear in the Table of Contents and Lists of Figures and Tables. 

What breaks an MS Word template?  One thing to avoid, as mentioned above, is editing or typing directly into the gray shaded field areas in the Table of Contents and Lists of Figures and Tables. To ensure that Field Shading is enabled. For a Windows PC, go to the Word File menu > Advanced options and go down to Field shading and select “Always”.  For Macs it is Word menu > Settings > View options > Field Shading: Always. This will turn all field coding in gray text.  

[image: Graphical user interface, text, application

Description automatically generated]

Additionally, never highlight body text in the ETDR and change the font type or size.  All the styles of text—Header 1, Header 2, body text, block text, captions, and others, are controlled by Word.  If you want to change the text appearances across the board for that type of text, go to the Styles pane and use the dropdown to the right of the style and “Modify.”  Do not have styles that have addendums like “body text + boldface + …”  The plusses should not be used because that leads to inconsistencies in your document.  

Never edit the Table of Contents, List of Figures, or List of Tables. The table style (and navigation) is built into the template.  Customizing the table style has often led to a broken template.  

Now, if you’ve been working on your document and broken the template somehow or things do not look right to you, take a deep breath. You do not have to worry.  All you need to do is download a blank template from the K-State Graduate School website, and carefully move your contents over to the new template.  

Copy and then paste in your text and apply the Heading styles to chapter and section titles. Apply the template Body text style to your paragraphs.  Insert images using Word, do not copy and paste.  Make sure that the images are .jpg, .png or .tif.  If you have tables, use Excel to scrub out the unnecessary formatting.  Use Excel to control for table width if the table width is wide (9” or so). Then copy and paste the table into Word. Place the table in a landscape format if needed.   

Then follow the directions to process your ETDR to final format.  It usually only takes an hour or so to copy and complete an ETDR in a working template.  

Help and support.  Some common challenges with Word files are described with solutions in the linked article.  If you need any help, please contact the IT Service Desk at servicedesk@ksu.edu or 785-532-7722.  Please reach out early to have questions addressed, so that you are not rushed to finalize your work.  

(02.2024) 


Your title here in sentence case (descending case)


by


Your Official Name (as appears in KSIS record)



(previous degrees with punctuation, format, and date order, as shown in example below)
B.S., Kansas State University, 2010



A REPORT



submitted in partial fulfillment of the requirements for the degree



(degree being earned in all capital letters, or BLOCK CAPS, as shown in examples below)
MASTER OF ARTS
MASTER OF SCIENCE



Name of your department (example: Department of Chemistry)
Name of your college (example: College of Arts and Sciences)



KANSAS STATE UNIVERSITY
Manhattan, Kansas


Graduation Year


	Approved by:  

Co-Major Professor (if needed)
Name of your major professor
	Approved by:

Co-Major Professor (primary)
Name of your major professor




[bookmark: Copyright]Copyright
© Firstname Lastname YYYY.
.


Abstract (or Executive Summary)
An abstract does not have a size limit at K-State as of 2017.  (In MS Word, just highlight your abstract, and a count will be available at the bottom left of your workspace.)
The executive summary highlights the main ideas of the report contents to be read by the executive receiving the report (traditional) and used by general readers to better understand the main points of the report.  
If you delete any lines on this page, KEEP the hidden Section Break below that controls page numbering.  How to see it:  Home tab > Paragraph section > click the[image: ]icon.  (On a Mac, the icon may be above the ribbon.)










Table of Contents
This Table of Contents is automatically created from content in this document.
1. In your chapters, apply Heading 1, 2, 3 styles to your headings and subheadings. 
2. Update the table below: Right-click anywhere in the list below and select Update Field. 
3. If a window pops up, select Update entire table and click OK.  
(DELETE HIGHLIGHTED TEXT BEFORE YOU PUBLISH).

List of Figures	vi
List of Tables	vii
Acknowledgements	viii
Dedication	ix
Preface	x
Chapter 1 - [Name of selection performed]	1
Biographical Information on the Composer	1
Theoretical Analysis	1
Stylistic and Technical Considerations	1
Chapter 2 - EXAMPLES and TIPS (this is a Heading 1) (Delete this chapter before publishing!)	3
YOU control the format of your content (Heading 2 example)	3
Use headings and subheadings to organize content (Heading 3 example)	3
Heading 4 is special; it can also be put in a paragraph (Heading 4 example)	3
Heading 5 also fits inside a paragraph (Heading 5 example).	3
Adding figure and table captions	4
First, ask your adviser about caption format	4
Second, set your caption style for figures, then tables (must be trained separately)	4
EXAMPLES	4
Difference between chapters and appendices	6
Quick tips for using the ETDR template, resources, and Word styles	7
Chapter 3 - HOW TO USE THE ETDR TEMPLATE (delete this chapter before publishing)	8
Chapters and appendices	8
Special styles in this template	8
Benefits of using styles to save time	9
References or Bibliography (choose one)	10
Appendix A - Enter Your Appendix Title Here	11
Figure and table captions in appendices	11
Appendix B - Using appendices, adding more, adding captions	12
Appendix C - Enter Your Appendix Title Here	13


[bookmark: _Toc472673162]List of Figures
The List of Figures is created from figure captions in this document.  See Chapter 6.
 1. In your chapters, insert figure captions. You must train them (1, 2, 3, or 1.1, 1.2, 1.3, etc.). 
2. Update the list below. Right-click anywhere in the list and select Update Field. 
3. If a window pops up, select Update entire table and click OK.

Figure 2.1 Figure captions in the ETDR template are now set below images by default.  You can change that and other formatting.	4
Figure 2.2 EXAMPLE of correct formatting on an ETDR title page. All details are important, including punctuation, capitalization, and the blank line after “Approved by:”.	5
Figure A.1 Correct caption in Appendix A.  See the ETDR website for instructions on changing appendix captions.	11
Figure B.1 EXAMPLE of caption in Appendix B, with appendix identifier and number.	12



[bookmark: _Toc472673163]List of Tables
The List of Tables is created from figure captions in this document.  See Chapter 6.
 1. In your chapters, insert table captions. You must train them (1, 2, 3, or 1.1, 1.2, 1.3, etc.). 
2. Update the list below. Right-click anywhere in the list and select Update Field. 
3. If a window pops up, select Update entire table and click OK.

Table 1.1 List of compositions	1
Table 1.2 Discography of Works	1
Table 2.1 Table captions in the ETDR template are set above tables by default.  You can change that and other formatting.	6
Table 2.2 EXAMPLE of an APA-formatted table.  APA style is not an ETDR requirement.	6



[bookmark: _Toc472673164][bookmark: Acknowledgements]Acknowledgements
The Acknowledgements page is optional.  If you include it, retain the Acknowledgements heading and enter your text here. 



[bookmark: _Toc472673166]Preface
The Preface page is optional.  If you include it, retain the Preface heading and enter your text here.
If you delete any lines on this page, retain the hidden Section Break below that provides proper page-number format.  To see the Section Break, click the Home tab > Paragraph section >[image: ]icon.  On a Mac, the icon may be above the ribbon. 



vii
[bookmark: _Toc472673167][bookmark: Chapter1][Name of selection performed]
{Add content here.  See Chapter 5 for details on using the ETDR template.}
[bookmark: _Toc401672389][bookmark: _Toc472673168]Biographical Information on the Composer
{Within the subheading, you may want to have further subsections.  Select Heading 3 for these subsections, as shown below }
[bookmark: _Toc401672431][bookmark: _Toc472673195]Table 1.1 List of compositions
	Name 
	Genre
	Publisher
	Difficulty
	Date Published

	1
	A1
	B1
	C1
	D1

	2
	A2
	B2
	C2
	D2

	3
	A3
	B3
	C3
	D3




[bookmark: _Toc401672432][bookmark: _Toc472673196]Table 1.2 Discography of Works
	Title 
	Recording Label
	Numerical Code
	Date Published

	1
	A1
	B1
	D1

	2
	A2
	B2
	D2

	3
	A3
	B3
	D3



[bookmark: _Toc401672394][bookmark: _Toc472673169]Theoretical Analysis
{Within the subheading, you may want to have further subsections.  Select Heading 3 for these subsections, as shown below}
[bookmark: _Toc401672395][bookmark: _Toc472673170]Stylistic and Technical Considerations
{Within the subheading, you may want to have further subsections.  Select Heading 3 for these subsections, as shown below}


Duplicate this additional chapters in this format as needed. Follow these steps: 
1. Insert a Page Break.
2. Type the headline that you want in regular text.
3. Select the text and apply a “Heading 1” style.
4. Copy the content from the template above to the new chapter.
5. Repeat as necessary.



[bookmark: _Toc458512425][bookmark: _Toc472673171]EXAMPLES and TIPS (this is a Heading 1)
(Delete this chapter before publishing!)
Timesaving elements like headings, and caption labels for figures and tables, are shown below.  You can modify headings and other styles to meet departmental requirements.  Find your Word version at k-state.edu/grad/etdr/word and read the “Using Styles” section.
[bookmark: _Toc458512426][bookmark: _Toc472673172]YOU control the format of your content (Heading 2 example)
From Chapter 1 and on, you and your adviser decide how to format the content.  The Graduate School wants consistency, so it will check your content for format issues such as: 
Blank pages
Figures and tables outside the margins 
Inconsistent line spacing, margins, page numbering, etc.

[bookmark: _Toc458512427][bookmark: _Toc472673173]Use headings and subheadings to organize content (Heading 3 example)
Headings 1-5 are for use in chapters (headings 6-9 are for appendices).  Many students only use Headings 1, 2, and 3 in chapters.  To organize a Heading 3 section, use Heading 4’s.
[bookmark: _Toc458512428][bookmark: _Toc472673174]Heading 4 is special; it can also be put in a paragraph (Heading 4 example)
Notice that Heading 4 has a half-inch indent.  This heading is designed to stand alone on a line or to fit inside a paragraph (which some students need for APA style).
[bookmark: _Toc458512429][bookmark: _Toc472673175]Heading 5 also fits inside a paragraph (Heading 5 example).  Be aware that headings inside a paragraph will be shown in the Table of Contents, but do not display in Word’s Navigation Pane.
[bookmark: _Toc458512430][bookmark: _Toc472673176]Adding figure and table captions
In chapters, each figure and table must have a caption/label, and each caption must be included in the List of Figures or List of Tables.  The easiest way is to INSERT a caption, which lets Word do all the work (applies Caption style, adds numbering, checks sequence, etc.).
In Word for Windows:  References > Captions section > Insert Caption
In Word for Mac:  Insert > Caption

[bookmark: _Toc458512431][bookmark: _Toc472673177]First, ask your adviser about caption format 
Your adviser may want your captions to look a particular way.  The Graduate School wants consistency, so the actual format is up to you and your adviser.  Consider these: 
Single- or double-spaced?  Bold or not?  Centered or left-justified?
Figures: Place captions above or below the image?
Tables:  Put captions above or below?

[bookmark: _Toc458512432][bookmark: _Toc472673178]Second, set your caption style for figures, then tables (must be trained separately)
1. Train your first figure caption.  For details, see “Captions for figures and tables” for your Word version at k-state.edu/grad/etdr/word.  
2. Train your first table caption.  
3. From then on, simply insert a caption (Insert > Caption); make sure the label is set to Figure or Table; and click OK.
[bookmark: _Toc458512433][bookmark: _Toc472673179]EXAMPLES
[image: ]
[bookmark: _Toc458512439][bookmark: _Toc472673191]Figure 2.1 Figure captions in the ETDR template are now set below images by default.  You can change that and other formatting.
[image: ]
[bookmark: _Toc458512440][bookmark: _Toc472673192]Figure 2.2 EXAMPLE of correct formatting on an ETDR title page. All details are important, including punctuation, capitalization, and the blank line after “Approved by:”.

[bookmark: _Toc458512442][bookmark: _Toc472673197]Table 2.1 Table captions in the ETDR template are set above tables by default.  You can change that and other formatting.  
	Table Text style (optional) puts even spacing above and below cell content

	Section 
	A
	B
	C
	D

	1
	A1
	B1
	C1
	D1

	2
	A2
	B2
	C2
	D2

	3
	A3
	B3
	C3
	D3



Table guidelines:
You and your adviser control table size, placement, page layout (Portrait or Landscape), appearance, fonts, and other details.  Page size is not limited.
If needed, tables and figures can extend one-half inch into the left and right margins. 
Tables must be legible in electronic and printed formats.

[bookmark: _Toc458512443][bookmark: _Toc472673198]Table 2.2 EXAMPLE of an APA-formatted table.  APA style is not an ETDR requirement.
	A-D
	A
	B
	
	C
	D

	1
	A1
	B1
	
	C1
	D1

	2
	A2
	B2
	
	C2
	D2

	3
	A3
	B3
	
	C3
	D3


Note. EXAMPLE of an APA table note (using a Table Note style). This is not an ETDR requirement. 

[bookmark: _Toc458512434][bookmark: _Toc472673180]Difference between chapters and appendices
Chapters contain essential information, including tables and figures.  Appendices are for supplemental data. There’s no limit on the number of chapters or appendices.
From Chapter 1 on, the content and format of your research is up to you, your adviser(s), and your graduate committee.  You have many choices on fonts, headings, paragraph style, tables, captions, etc.  Consistency is essential. 
For details, see the Graduate School Requirements and Guidelines for Electronic Theses, Dissertations, and Reports at k-state.edu/grad/etdr/create/guidelines.html.

[bookmark: _Toc458512435][bookmark: _Toc472673181]Quick tips for using the ETDR template, resources, and Word styles
 “I wish I would have used the template earlier!” is a common lament by graduate students.  Save yourself time and stress by learning to use features in the ETDR templates.
1.  When you start writing, use an ETDR template.  If you only need one chapter, make a copy of the template and delete everything except Chapter 1.
2.  Get a head start with short videos and resources for the ETDR template.  
Windows Word 2010 (also good for 2013-2016): 
Word 2010 resources > Configure Word 2010 for the ETDR Template
Mac Word 2011 (also good for 2016):
Word for Mac 2011 resources > Configure Word … Word for Mac 2011

3.  Get ETDR help sooner.  Don’t wait until you’re near to finishing.
Attend ETDR walk-in clinics and presentations, listed on the ETDR homepage.
Use the ETDR Service Request form to get a meeting in person or by webconference.
Contact the IT Help Desk, 785-532-7722, helpdesk@k-state.edu.
Use resources on the ETDR website.

4.  Learn to use styles, which have time-saving features.  A style a set of formatting characteristics such as font size, indents, line spacing, alignment, etc.  When you modify a style, it changes all text using that style.  You can modify styles in the ETDR Word template to meet your departmental requirements. Those styles include:
Bibliography = for citations; single-spaced, hanging indent, and a blank line after. 
Body Text = for basic content; double-spaced with a paragraph indent.
Caption = for labeling figures and tables.
Heading 1 = for “Chapter” title in 1, 2, 3 format.
Headings 2-5 = for subheadings in chapters. 
Heading 6 = for “Appendix” title in A, B, C format.
Headings 7-9 = for appendix subheadings.
Page Heading = for sections names not to be in the Table of Contents (like Abstract).
Page Heading TOC = for section names that must be in the Table of Contents.
Table Text = for even spacing top/bottom/left in cells; single-spaced Normal font.

[bookmark: _Toc472673182]HOW TO USE THE ETDR TEMPLATE
(delete this chapter before publishing)
[bookmark: _Toc472673183]Chapters and appendices
Chapters should contain your essential information, including tables and figures.  Appendices are for supplemental data that you want to include.
There’s no limit on the number of chapters or appendices.
From Chapter 1 on, the content and format of your research is up to you, your adviser(s), and your graduate committee.  You have many choices on fonts, headings, paragraph style, tables, captions, etc.  Consistency is essential. 
For details, see the Graduate School Requirements and Guidelines for Electronic Theses, Dissertations, and Reports at k-state.edu/grad/etdr/create/guidelines.html.

[bookmark: _Toc419474312][bookmark: _Toc472673184]Special styles in this template
This template uses “styles” time-saving features in Word. A style is a combination of formatting characteristics (similar to clothing styles and vehicle styles).  It can include font size, color, line spacing, paragraph alignment, and more.  See Chapter 4 for examples using some of these styles.
· Heading 1 provides a “Chapter” title in 1, 2, 3 format.
· Headings 2-5 are for subheadings in chapters.
· Heading 6 provides an “Appendix” title in A, B, C format.
· Headings 7-9 are for appendix subheadings.
· Body Text is for basic content and is double-spaced with a paragraph indent.
· Bibliography is single-spaced, with a hanging indent and a blank line after. 
· Caption is for labeling figures and tables.
· Page Heading is used on sections headings such as Abstract and Copyright.
· Page Heading TOC is for section headings that must display in the Table of Contents.
· Table Text is a Normal font that’s single-spaced, with even margins all around.

[bookmark: _Toc419474313][bookmark: _Toc472673185]Benefits of using styles to save time
1. Fast updates of the Table of Contents, List of Figures, and List of Tables. 
Put your cursor in the content field, right-click, and select Update Field. 
(Sometimes a window pops up. Click Update entire table and OK.)

2. Headings create a roadmap for fast and easy navigation. 
Use the clickable outline in the Navigation Pane (View > Navigation Pane).

3. Modifying a style in the Styles Menu will change all occurrences in your document. To display the Styles Menu in Windows: Home tab > Styles section > click small arrow in bottom right corner.  To display it in Mac: Toolbox icon > Styles tab.  


Contact the IT Help Desk, 785-532-7722, helpdesk@k-state.edu, if you need assistance.



[bookmark: _Toc472673186]References or Bibliography (choose one)
Include a separate chapter for your references or bibliography.  Citations must be followed by a blank line, and can be single- or double-spaced.  The format is up to you and your adviser.
As shown by the examples below, a Bibliography style with single spacing and a hanging indent is available in this document to meet the needs of many students.  You can modify the style as needed.

Devine, P. G., & Sherman, S. J. (1992). Intuitive versus rational judgment and the role of stereotyping in the human condition: Kirk or Spock? Psychological Inquiry, 3(2), 153-159.
Hodges, F. M. (2003). The promised planet: Alliances and struggles of the gerontocracy in American television science fiction of the 1960s. The Aging Male, 6(3), 175-182.
James, N. E. (1988). Two sides of paradise: The Eden myth according to Kirk and Spock. In D. Palumbo (Ed.), Spectrum of the fantastic (pp. 219-223). Westport, CT: Greenwood.

The Bibliography style does not format your citations into a specific style such as American Psychological Association (APA) or Modern Language Association (MLA).  You must enter your citations in the style used by your department, or use bibliographic software such as RefWorks, EndNote, or Mendeley.
For assistance with citations, contact K-State Libraries and see its Citations and Bibliographies information at guides.lib.k-state.edu/citations.


[bookmark: _Toc472673187]Enter Your Appendix Title Here
This area is used for your score analysis and supplemental data, but is not required.
There’s no limit on the number of appendices.
Appendix headings must be labeled A, B, C, etc. 
For an option of reporting a score analysis and instructions see the following web links 
· SCORE ANALYSIS TEMPLATE 
· Instruction for completing Score Analysis
· Inserting Score Analysis into Report


[bookmark: _Toc472673188]Figure and table captions in appendices
Captions can include the chapter number and appendix alphabetical designations, or can be listed as Figures 1, 2, 3, and Table 1, 2, 3, etc.  Visit with your adviser to determine the caption styles and placement that meet your department’s requirements.
Microsoft Word has trouble dealing with the complexity of numbered chapters versus alphabetical appendices.  If you decide to include chapter/appendix designations in caption labels, inserting a caption in an appendix will cause it to be labeled as though it were in a chapter.  For example:  The figure caption below was labeled “Figure 6.1” when inserted but is required to be “Figure A.1”.
[bookmark: _Toc472673193]Figure A.1 Correct caption in Appendix A.  See the ETDR website for instructions on changing appendix captions. 
[image: MP00640_] 
For a way to fix appendix caption labels, see the Appendices section for your Word version on the ETDR website at k-state.edu/grad/etdr/word.

[bookmark: _Toc458512438][bookmark: _Toc472673189]Using appendices, adding more, adding captions
Appendices are optional and are for supplemental data, meaning anything you and your adviser want to add that helps explain your research, including survey tools, images, data sets, programming code, letters and forms (usually in PDF format), etc.
Appendix headings must be labeled A, B, C, etc.  (Tip: Use Heading 6.)
Heading styles 7, 8, and 9 in the ETDR template are for appendix subheadings.
There is no limit on the number of appendices.

Adding more appendices
1. Insert a Page Break (Insert > Page Break), so the next appendix starts on a new page.
2. Type the name of the appendix and apply a Heading 6 style (Home > Heading 6).  
3. Word provides the “Appendix” label and correct alphabetical sequence.
Adding appendix captions
If captions in your chapters are numbered 1, 2, 3, etc., that numbering format should continue through your appendix captions.  If captions in chapters are numbered 1.1, 1.2, 1.3, etc., your appendix captions must match that format by using A.1, A.2, A.3, etc.
[image: MP00640_] 
[bookmark: _Toc458512441][bookmark: _Toc472673194]Figure B.1 EXAMPLE of caption in Appendix B, with appendix identifier and number.

A common problem with appendix captions is that Word will label them as though they’re in a chapter (“Figure B.1” above was originally “Figure 6.1”).  
One solution: Carefully delete the chapter number and type in the desired appendix identifier, without changing the figure number.  NOTE: It’s best to do this after you’ve inserted all your captions, or Word may add chapter numbers again whenever you insert a new caption.
[bookmark: _Toc472673190]Enter Your Appendix Title Here
If you need additional appendices, follow these steps: 
1. Insert a Page Break.
2. Type the headline that you want in regular text.
3. Select the text and apply a “Heading 6” style.  
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